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What is Power Point?  

Power Point is presentation software that can help you to create effective “slide based” 

presentation OR Power Point is a component of Microsoft Office that is used to create 

professional-quality presentation. 

Usage of Presentation: 

1. Presentations: A collection of your slides handouts, speaker‟s notes and your outline, 

all in  

one file  

2 .Slides: Individual pages of your presentations Slides can have titles text graphs 

objects  

and shapes  

3 .Handouts: You can also print your slides as handouts — with two three, four six or 

nine  

slides on a page — which your audience can use for future reference Handouts show 

only the  

slides they don‟t include any corresponding notes  

4. Speaker‟s notes: Create and print speaker notes. A small image of the slide on each 

note  

page along with any notes you type on the notes page  

5 .Outline: In the outline form your titles and main text appear. 

 

What do you mean by the presentation? What are the different ways to create a 

presentation? What are the different ways to run a presentation? 

Presentation is an area to display various information in clear and concise manner .The 

advantage of using it is that user can get clear idea if there is any complexity in any 

topic within a limited time.  

Ways to create it:  
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1 Using AutoContent wizard  

2. Blank Presentation  

3. Using Templates  

4. Opening and Changing already existing presentation  

Ways to run presentation:  

1. Select View->Slide show  

2. Press F5 key  

3. Click on Run icon that is available at bottom-left corner. 

What is the extension of presentation file and presentation show?  

.pptx &.ppsx  

 

Types of Views:  

The different views by which you can view your presentation are : 

1. Normal view: Normal view contains three panes: the outline pane, the slide pane, 

and the notes pane. These panes let you work on all aspects of your presentation in 

one place. You can adjust the size of the different panes by dragging the pane borders. 

 

Outline pane: Use the outline pane to organize and develop the content of your 

presentation. You can type all of the text of your presentation and rearrange bullet 

points, paragraphs, and slides.  

Slide pane :In the slide pane you can see how your text looks on eaphs1ide You can 

add graphics, movies, and sounds create hyperlinks, and add animations o individual 

slides. 

Notes pane: The notes pane lets you add your speaker notes you want to share with the 

audience. If you want to have graphics in your notes, you must add the notes in notes 

page view.  

These three panes are also displayed when you save your presentation as a Web page 

The only difference is that the outline pane displays a table „of contents so that you can 

navigate through your presentation  

2 .Outline view :In Outline view, PowerPoint does not display any graphics in the slides 

Instead it displays only the text This view is helpful when you want to enter a lot of text 

in your slides You can easily move ir6rr one slide to another to enter or edit the slide 

text This view also helps out to delete add copy and paste slides This view too allows 

you to alter the sequence of slides in your presentation  



Unit-3 BBA (ITM) SEM-1 PCSP 

3. Slide view: in Slide view, PowerPoint displays and edits a single slide on the screen  

4. Slide Sorter view :The Slide Sorter view displays miniature versions of your slides. 

In this view, you see several slides on the screen. It is easy to organize the slides within 

the presentation. This view also helps you to delete, add, copy and paste slides. The 

Slide Sorter view also helps us to set slide timings for a slide show. It also helps us to 

pick the transitions you want to use to advance from slide to slide.  

5. Notes Pages view: In Notes Pages view, you see a page that includes the slide 

image at the top of the page and room for notes toward the bottom. You can change the 

size and placement of both by dragging the resizing handles. The Notes Pages view 

enables you to type the speaker‟s notes in the bottom part of the page. The text entered 

in the Notes Pages area can be formatted using the normal editing commands. The 

Notes Pages text is not displayed when you ru a slide show. However, you can print the 

slides with speaker‟s notes.  

 

Explain slide sorter view. Give its uses.  

In slide sorter view, you see all the slides in your presentation on screen at the same 

time, displayed in miniature. This makes it easy to add, delete, and move slides, add 

timings, and select animated transitions for moving from slide to slide. You can also 

preview animations on multiple slides by selecting the slides you want to preview and 

then clicking Animation Preview on the Slide Show ribbon. 

Compare Slide view and outline view 

Slide View Outline View 

In this user can verify one slide at a time. In this user can see an overview of all text 

in the presentation 

It is difficult to enter and edit text item. It is easier to enter and edit text item. 

The user can see how the actual slides 

appear. 

It is not possible to see how the actual 

slides appear. 
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How to Insert/Create a New Slide? 

On the Home ribbon, click New Slide Or press Control + M  

How to duplicate slides within a presentation1?  

I. Select the slide or slides you want to duplicate  

II. II. On the Home ribbon, click Duplicate Slide.  

Note: You cat also duplicate slides by using the keyboard shortcut CTRL+SHIFT+D or 

CTRL+D. 

 

How to delete a slide?  

I Select the slide you want to delete  

II On the Home ribbon click Delete Slide  

Note: To delete multiple slides switch to slide sorter view Hold down CTRL while you 

click the slides and then click Delete Slide . 

 

How to Copy a slide from one presentation to another?  

I. Display the slide that will precede the slide you want to insert.  

II. On the Insert ribbon, click Slides from Files.  

Ill. Find and select the presentation you want to copy a slide from.  

IV. Click Display.  

V. Select the slide or slides you want to copy, and then click Insert.  

Note: To copy an entire presentation, click Insert All. 

How to go a specific slide?  

In this 

view 

Do this 

Normal In the slide pane, drag the vertical scroll bar until the slides number you 

want appears. 

In the outline pane, click the slide number. 
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Slide 

Sorter 

Double-click the slide. 

Slide Show Right- click, point to Go on the shortcut menu, and then click Slide 

Navigator. Double-click the title of the slide you want to go to . 

How to look at the next slide?  

Do one of the following:  

I. Click Next Slide button in the lower-right corner of the slide pane.  

II In the outline pane, click the next slide number. 

Do one of the following:  

I Click Previous Slide button in the lower-right corner of the slide pane  

II In the outline pane click the previous slide number . 

 

Flow to zoom in or out on a slide? 

I .On the Standard toolbar, click the arrow next to the Zoom box and then magnification 

you want. 

 

How can you insert a text in a slide? 

You can insert a text in slide using following different ways  

I. Add text to a placeholder.  

II Add text by using the Text Box tool . 

III. Add text to an AutoShape  

IV.lnsert a WordArt drawing object  

 

How to Increase or Decrease a Font Size of text? 

I. Select the text you want to change.  

II. Click Increase/Decrease Font Size Icon that is available on formatting toolbar.  

How to type notes while working on a presentation?  

I. Click the notes pane, and then type your notes for the current slide.  

To see more of the notes pane, point to the top border of the notes pane until the 

pointer becomes a double-headed arrow, and then drag until the pane is the size you 
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want.  

II. Use the outline pane to move to other slides you want to add notes to.  

 

Note: You can add drawing objects and pictures to notes pages. To do this, click Notes 

Page on the View menu, and then add the items you want. Drawing objects and 

pictures are not displayed in the notes pane, but appear when you work in notes page 

view or when you print slides with notes.  

 

Write down the different ways to insert a picture in your slides  

1.Click on clipart icon from the drawing toolbar, which opens a insert picture dialog box. 

Select picture categories and from it select picture to insert.  

2. Select clipart option from the format, picture command.  

3. Double click to Add clipart” text, which is written on slide.  

 

What is transition?  

It is a special effect used to introduce a slide during a slide show. User can choose the 

transitions and can vary the speed of transition as desired. User can set a different 

transition effect for each slide.  

 

Write down the steps for defining transition effect for any slide.  

1. Select the slide for which you want to define transition. 

2. From the Slide Show menu select Slide Transition command it displays slide 

transition dialog      box.  

3. Select type of effect from the effect list box  

4. Select the speed of effect from the speed radio button  

5. From the Advance select any one appropriate option If select the-Automatically after 

option then specify the time using spinner <Select sound type from the sound list box if 

you want to insert.  

6. Click on Apply button If you want to apply it for all slides then click on Apply All button 

If you want to cancel it then click on cancel button . 

Write down the name of different ‘types of transition effect that you can add to 

your presentations  
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Box In Box Out Cover Left, Cover Right, Cover Up Cover Down, Cover Left-Down 

Cover Left- Up Cover Right-Down Cover Right-Up, Cut Dissolve etc  

 

Slide layouts  

Slide layouts contain formatting, positioning, and placeholders for all of the content that 

appears on a slide. Placeholders are the containers in layouts that hold such content as 

text (including body text, bulleted lists, and titles), tables, charts, SmartArt graphics, 

movies, sounds, pictures,  

and clip art. And a layout contains the theme (colors, fonts, effects, and the background) 

of a slide as well.  

 

PowerPoint includes nine built-in slide layouts, or you can create custom layouts that 

meet your specific needs, and you can share them with other people who create 

presentations by using PowerPoint. The following graphic shows the slide layouts that 

are built-in to PowerPoint. 

How to change the layout of a slide?  

1. In normal or slide sorter view, select the slide you want to change.  

2. On the Formatting toolbar, click Common Tasks, and then click Slide Layout.  

3. Use the scroll bar to view all layouts, click the one you want, and then click Apply.  

4. Rearrange any overlapping or hidden objects to fit the new layout 

.  

How to add space before after and between lines of a paragraph?  

I. In the slide pane, click anywhere in the paragraph you want to add space before.  

II. On the Format menu, click Line Spacing.  

III. Select the appropriate option, enter the amount of spacing you want, and then click 
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Lines or Points.  

IV. If you want to see a preview then click on preview button. If you want to apply it then 

click on Ok button otherwise click on cancel button to cancel it.  

 

How can you run presentation continuously?  

• Select the setup show from the slide menu.  

• Select „Loop continuously until Esc’ from the show type.  

• If you want to apply it for all slides then select „All‟ from the slide otherwise specify 

the slide numbers for which you want to apply in „From‟ and „To‟ box.  

• Select the appropriate advance slide option.  

• Click on OK button. .  

List out the different types of presentations you can create using Power Point.  

General  

Corporate  

Projects  

Sales/Marketing  

Write use of Slide Color Scheme. 

It has a set of compatible colors Each of this color is used for specific slide elements 

The elements of it are  

Background color :The color of slide background i e area of slide behind the objects of 

slide  

Text & Lines :The color of drawn lines, bulleted list text and text created with text box  

Shadows: The color of the object s shadows  

Title Text: the color of the title-object text  

Fills: The color inside the filled objects  

Accents: The set of 3 colors used for graphs and for secondary slide items  

 

What is animation? Explain custom animation. What are the different methods to 

animate slides’? How can you apply the same animation effect to all slides at a 

time?  

It is a special effect that determines how the objects appear on the slide during the 

presentation .It is also referring as build. Power Point has built-in or customizes 

animation effects. We can give the animation during slide show or normal view.  
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How can you insert same comment in all slides?  

From the insert menu select insert comment command. It displays a comment box  from 

reviewing toolbar. You can hide & delete a comment. You can also move a comment 

from one place to another within a slide like other objects.  

 

How can you insert audio/video? 

From the insert menu select Movie and Sound command. From that select appropriate 

command.  

 

Rehearse Timing 

The “Rehearse Timings” option is an option that allows you to rehearse the time it takes 

to go through a slide, and then, you stop the time so that when you present the 

PowerPoint, each slide you‟ve rehearsed the timing of transitions for will change about 

the same time you are done. Instead of having to click every time to do something 

(change slides, have pictures enter, etc.) it will do it on its own and run through it with 

your timings.  

 

Write down the steps to record the timings of the presentation  

1. On the Slide Show menu, click Rehearse Timings to start the show in rehearsal 

mode.  

2. Click the advance button when you‟re ready to go to the next slide.  

3. When you reach the end of the slide show, click Yes to accept the timings or No to 

start over.  

Note: If you know the timing you want for a slide, you can enter it directly in the Slide 

Time box of the Rehearsal toolbar. 

 

What is Hyperlink?  

A hyperlink is a connection from one slide to another slide, Web page or a -file The 

hyperlink itself can be text or an object such as a picture graph shape or WordArt. 
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If the link is to another slide, the destination slide is displayed In the PowerPoint 

presentation. If the link is to a Web page, network location or different type of file the 

destitution page or file is displayed in the appropriate application or in a Web browser  

In PowerPoint, hyperlinks become active when you run your presentation, not when you 

are creating it  

When you point to a hyperlink the pointer becomes a hand indicating that it is 

something you can click Text that represents a hyperlink is displayed in underlined and 

in a color that coordinates with your color scheme Pictures, shapes and other object 

hyperlinks have no additional formatting .You can add action settings such as sound or 

highlighting to emphasize hyperlinks. 

 

When you create a hyperlink to something other than a slide its destination is encoded 

as a URL (Uniform Resource Locator) such as http ://www microsoft.corn/ or file 

://Computer Name/Shared Folder/FileName.htm. When you create a hyperlink to a page 

or file on a local file system, the hyperlink destination is represented by the path to the 

file such as C \Windows\file xIs . 

 

Create a hyperlink to a location in the current presentation  

1. Select the text or object that you want to represent the hyperlink.  

2. Click Insert Hyperlink.  

3. Under Link to, click Place in This Document.  

4. In the list, select the slide you want to go to.  

 

Action Buttons  

An action button is a ready-made button that you can insert into your presentation and 

define hyperlinks.  

Use action buttons when you want to include buttons with commonly understood 

symbols for going to the next, previous, first, and last slides. PowerPoint also has action 

buttons for playing movies or sounds. Action buttons are most commonly used for self-

running presentations— for example, at a booth.  
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Insert an Action Button  

1. Select the slide you want to place a button on.  

2. On the Slide Show menu, point to Action Buttons, and then select the button you 

want— for example, Home, Back or Previous, Forward or Next, Beginning, End, or 

Return.  

3. Click the slide.  

4. Make sure that „Hyperlink to‟ is selected. Click OK to accept the proposed hyperlink in 

the Hyperlink to list, or click the arrow and select the link you want.  

Add music or sound effects to a slide  

1. Display the slide to which you want to add music or sound effects.  

2. On the Insert menu, point to Movies and Sounds, and then do one of the following: 

 Insert a sound file : -  

o Click Sound from File, locates the folder that contains the file, and then double 

click the file you want. ,  

  Insert a sound clip from Clip Organizer. -  

o Click Sound from Clip Organizer, scroll to find the clip you want, and click itto 

add it to the slide. 

3. When a message is displayed, do one of the f6liowing:  

 To play the music or sound automatically. when you „go to” the slide, click  

Automatically.  

  To play the music or sound -only when you click the sound icon, click When  

Clicked.  

4. To adjust settings for when the sound file stops: click the sound icon, right-click, and 

on the shortcut menu, click Custom Animation.  

5. In the Custom Animation task pane, click the arrow on the selected item in the 

Custom Animation list, and then click Effect Options.  

6. On the Effect tab, under Stop playing, do one of the following:  

 To stop the sound file on mouse-click of the slide, select On click (the default).  

  To stop the sound file after this slide, click after current slide.  



Unit-3 BBA (ITM) SEM-1 PCSP 

 To keep, the sound tile playing for several slides, click After, and then set the 

total number Of slides the file should play on.  

 

Disclaimer: The study material is compiled by Ms.Aishwarya Chauhan.The basic 

objective of this material is to supplement teaching and discussion in the classroom in 

the subject. Students are required to go for extra reading in the subject through Library 

books recommended by Sardar Patel University, Vallabh Vidyanagar. Students should 

also consult the subject teacher for the solution of their problems in order to enhance 

their subject knowledge.  

 

 

 

 

 


